AppXtender Document Manager -
(Application Xtender)
AppXtender Document Manager - (Application Xtender)  
Introduction

Document imaging is the conversion of paper documents into electronic images stored on computer. Once stored, these electronic images should be index for quick retrieval.

Document Manager is a local installed software that allows a central pool of information to be open, import, modify, index, store and retrieval of documents.

BDMS provides integration with the Banner application suite. There are five specific integration areas:
- Human Resources
- Finance
- Student
- Financial Aid
- Advancement

With Document Manager you can:

- Tie image and document data to Banner information by scanning and indexing.
- Deliver the right information to your different users when, where and how they need it
- Improve collaboration between different users or departments
- Improve productivity by eliminating time wasted searching paper files or sifting through unrelated information
- Reduce cost by minimizing printing and duplication of documents, and by reducing the amount of physical storage required
## Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation</td>
<td>An annotation is a note or a shape added to a document or batch page, typically to focus attention on a particular part of the page. Users can use annotations to comment on the contents of a page, block areas of the page from view, or highlight important information. When a user creates an annotation, it is associated with the AppXtender document page on which he or she created it. Annotations are edited and stored separately from the image, but they are displayed along with the image in ApplicationXtender. The types of annotations available include text, highlighting, lines, arrows, shapes, and rubber stamps.</td>
</tr>
<tr>
<td>Append</td>
<td>Attach one or more pages to the end of a document.</td>
</tr>
<tr>
<td>Batch</td>
<td>A group of electronic files for one or more documents, each of which has one or more pages.</td>
</tr>
<tr>
<td>Check In/Check Out Mode</td>
<td>When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. Users must check out a document in order to modify it. If they do not check the document out, it is opened in read-only mode and cannot be modified.</td>
</tr>
<tr>
<td>Document</td>
<td>A document is a page or group of pages stored in an application and identified by index information. Each page of a document is comprised of a single object such as a scanned image file or a word processing document. To create a new document, users add an object to an application and attach index information to it. Subsequent objects can be added as additional pages of the same document.</td>
</tr>
<tr>
<td>Document Type</td>
<td>User-defined code that identifies each type of document that is stored and indexed in a BXS application.</td>
</tr>
<tr>
<td>Index</td>
<td>An AppXtender index contains a group of fields where descriptive information pertaining to documents can be stored. When a document is stored in an application, the index values you enter identify the document.</td>
</tr>
<tr>
<td>Last Index</td>
<td>The Last Index function allows users to populate the index fields for one record with the index values used for the previous record.</td>
</tr>
<tr>
<td>Page</td>
<td>The word &quot;page&quot; typically implies a single entity. Since AppXtender supports multiple object types, the term &quot;page&quot; is redefined within AppXtender to mean a single object. A very long word processing file is considered a page to AppXtender. A page could also be, for example, a single scanned image, a 30-minute video clip, or an audio recording. Each page of a document has the same index record attached</td>
</tr>
<tr>
<td>Query</td>
<td>A query is where a user can search for documents with index values that match one or more values in a specified range of values. This allows users to narrow a search within a single index field to get more concise and accurate results.</td>
</tr>
<tr>
<td>Redactions</td>
<td>A redaction is a filled and opaque annotation shape, which can be used to secure or hide portions of image and text document pages. Users can apply redaction to all available shapes: lines, freehand lines, arrows, rectangles, rounded rectangles, and ovals. When applied, the area of the page behind the redaction is not visible.</td>
</tr>
<tr>
<td>Wildcard Query</td>
<td>A query in which a single asterisk (*) is used as a wildcard in search criteria to match one or more characters. This allows users to control the number of documents returned in a result set by narrowing search results.</td>
</tr>
</tbody>
</table>
General Notes: Overall

- Scanning process should be completed in QuickScan Pro. Limit scanning can be completed in Document Manager provided you have the recommend scanner attached your PC.
- Document can be rotated while in Document Manager but the new orientation cannot be saved.
- Once a batch has been exported into an application anyone that has security rights to the application can see the batch.
- If multi people are viewing one document whoever opens the document first has the modify rights all others are read only rights
Accessing AppXtender Document Manager

In order to gain access to ApplicationXtender Desktop the following steps will need to be taken:

1. Click on Start – All Programs
2. Click on ApplicationXtender Desktop
3. Select Document Manager
4. A login prompt will appear, log in using your Banner username & password.
5. Click Login
Exiting AppXtender Document Manager

It is important to exit the software via the menu bars and not by clicking on the red cross in the application window, this could leave a session open with the associated license taken and could lead to a shortage of available licenses.

You should always exit the software once you have completed your task. If you remain connect to Document Manager but it is not in use it could result in a shortage of available licenses.

1. From the **Menu Bar** select **File** then select **Exit**
Commands in AppXtender Document Manager

The Menu bar comprises of a series of drop down menus which can be used to carry out all tasks within AppXtender Document Manager. The following pages highlight the most often used menu options.

File Menu

The File Menu contains commands for opening, closing and saving documents; user configuration, printing and exiting the system.

Edit Menu

The Edit Menu provides access to cut, copy and paste commands and query functions.

View Menu

The View Menu provides access to commands which alter the way the electronic image appears. You may change between different view options, alter the size and orientation of document, split the application window and viewing document indexes.
Document Menu

The Document Menu provides commands specific to manipulating documents. This includes navigating through document pages, indexing, exporting and reformatting for print and checking documents in or out of the system.

Note: By checking out a document, the user locks the document against edits by other authorized users of the system.

Page Menu

The Page Menu provides commands specific to individual page within a batch. This includes adding, deleting, replacing, or exporting a page.

Scan Menu

The Scan Menu allows you to directly scan in new documents and configure a scanner which is connected to your PC.

Annotate Menu

The Annotate menu contains commands which allow users to mark up documents. Ink annotations can be added for information and documents can be stamped electronically providing required information such as receipt date.

Note: Document annotation should be used in line with the Departmental Quality Assurance Standard.

Utilities Menu

The Utilities Menu contains commands related to document batches.
**Window Menu**

The Window Menu contains commands related to how the on screen elements are displayed.

**Help Menu**

The Help Menu provides the application help files which can be searched by topic.
AppXtender Document Manager Views

The View Modes of ApplicationXtender allow you to manipulate images in several different ways.

Application View

An Application is the highest level of organization in AppXtender. This view lists applications and queries in a tree structure, similar to Windows Explorer. You can store or retrieve documents within applications and expand or collapse applications to view or hide their associated lists of queries.

When a user logs into ApplXtender Document Manager, it defaults to Application View, requiring the user to select which application they wish to add or retrieve documents.

Note: The Application view will be based on the user security. You may not have access to view all folders shown below. Please have your Supervisor submit a Banner Access Form (new employees) or Footprint request (existing employees) to gain access to the needed folders.
**Query View**

The Query view allows you to search for desired documents using keywords. You may search for documents via index information or via full-text information.
Document Display View

The Document Display view calls up the stored image of your selected document. Within the view you may pan around the image's dimensions or select a portion of the image and manipulate it in various ways.

10 Integrating BDMS with Self-Service Banner

Banner Document Management Suite (BDMS) provides a Self-Service Banner integration that allows you to configure SSB to use BDMS packages to provide links to AppXtender Web Access .Net (WX.Net) for document query/view or import/upload.

Note
BDMS SSB Integration requires AX Web Access .Net. It is not certified with AX Web Access Java 2.

Integration occurs using a Single Sign-on authentication from a Self-Service Banner page, such as Finance’s “View Document” page, to a WX.Net session for document retrieval or upload from BDMS. For example, “Query” and “Import” links to WX.Net can be provided on a SSB page based on options that are defined by your institution.

The following instructions will guide you through:

1. Set-up of the Super-User IDs that will be used for the Single Sign-on authentication.
2. Set-up of the parameters that are passed in the URL string from SSB to WX.Net.
3. Adding the optional BDMS package call in the applicable SSB package.

Before Setting Up BDMS SSB Integration

1. Define a Super-User ID:

The super-user ID should be a unique ID created specifically for the SSB to BDMS integration. It is used as the login ID for the Single Sign-on between SSB and the WX.Net session.

- It is not the Self-Service user login ID.
- It is an AX user.
- For Finance SSB and HR SSB functions, it will be necessary to set-up the super user ID on their respective security forms in Banner.
**Index View**

The Index view lists index terms for a document. You may enter index information for new documents here, or view or change index information for existing documents.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCUMENT ID</td>
<td>0273820</td>
</tr>
<tr>
<td>BANNER DOC TYPE</td>
<td>INVOICE</td>
</tr>
<tr>
<td>DOCUMENT TYPE</td>
<td></td>
</tr>
<tr>
<td>TRANSACTION DATE</td>
<td>01-Sep-2009</td>
</tr>
<tr>
<td>VENDOR ID</td>
<td>901134717</td>
</tr>
<tr>
<td>VENDOR NAME</td>
<td>KY STATE TREASUR</td>
</tr>
<tr>
<td>FIRST NAME</td>
<td></td>
</tr>
<tr>
<td>PIDM</td>
<td>1134717</td>
</tr>
<tr>
<td>ROUTING STATUS</td>
<td>(Null)</td>
</tr>
<tr>
<td>ACTIVITY DATE</td>
<td>2009-09-23 08:57:49</td>
</tr>
</tbody>
</table>

**Thumbnail View**

The University is not implementing Thumbnails View within BDMS.
Toolbars within AppXtender Document Manager

The built-in toolbars provide easy access to commonly used functions with Document Manager.

**Viewing Toolbars**

To add or remove toolbars from the application window:

1. From the **Menu Bar** select **View** then **Toolbars**

![Toolbars](image)

**Tool Bar Icon Descriptions**

To view details of any Toolbar Icon:

1. Hover over the icon with the mouse and a description of its function will be displayed on screen

![Run query](image)
**Standard Toolbars**

All toolbars can be edited by adding or moving icon with the following steps:

1. **Right Click** anywhere on the toolbar, select **Customize**

2. You have two options:
   - **Available toolbar buttons** – Highlight button, Click **Add**
   - **Current toolbar buttons** – Highlight button, Click **Remove**

3. Once select is made click **Close**

**Main Toolbar**

<table>
<thead>
<tr>
<th>Function</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle the Application view</td>
<td><img src="image1" alt="Icon" /></td>
</tr>
<tr>
<td>Toggle the Query view</td>
<td><img src="image2" alt="Icon" /></td>
</tr>
<tr>
<td>Toggle the Thumbnail view</td>
<td><img src="image3" alt="Icon" /></td>
</tr>
<tr>
<td>Create a new document</td>
<td><img src="image4" alt="Icon" /></td>
</tr>
<tr>
<td>Run a query</td>
<td><img src="image5" alt="Icon" /></td>
</tr>
</tbody>
</table>
**Annotation Toolbar**

Annotations allow users to add notes to a page, block areas from view, or highlight selected information. Annotations can be configured so that only certain logins have access to certain annotations.

<table>
<thead>
<tr>
<th>Function</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle selection of annotations</td>
<td></td>
</tr>
<tr>
<td>Text annotation</td>
<td>[T]</td>
</tr>
<tr>
<td>Highlight annotation</td>
<td>[+]</td>
</tr>
<tr>
<td>Freehand line annotation</td>
<td>[L]</td>
</tr>
<tr>
<td>Annotation Type</td>
<td>Icon</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Line annotation</td>
<td>![Line Icon]</td>
</tr>
<tr>
<td>Arrow annotation</td>
<td>![Arrow Icon]</td>
</tr>
<tr>
<td>Rectangular annotation</td>
<td>![Rectangle Icon]</td>
</tr>
<tr>
<td>Rounded rectangular annotation</td>
<td>![Rounded Rectangle Icon]</td>
</tr>
<tr>
<td>Oval annotation</td>
<td>![Oval Icon]</td>
</tr>
<tr>
<td>Polyline annotation</td>
<td>![Polyline Icon]</td>
</tr>
<tr>
<td>Polygon annotation</td>
<td>![Polygon Icon]</td>
</tr>
<tr>
<td>Erase annotation</td>
<td>![Erase Icon]</td>
</tr>
<tr>
<td>Toggle filled/hollow annotation</td>
<td>![Fill/Empty Icon]</td>
</tr>
<tr>
<td>Toggle annotation redaction</td>
<td>![Redact Icon]</td>
</tr>
<tr>
<td>Select default annotation group</td>
<td>![Default Group Icon]</td>
</tr>
<tr>
<td>Select all annotations</td>
<td>![Select All Icon]</td>
</tr>
<tr>
<td>Bring selected annotation to front</td>
<td>![Bring to Front Icon]</td>
</tr>
<tr>
<td>Send selected annotation to back</td>
<td>![Send to Back Icon]</td>
</tr>
<tr>
<td>Toggle showing/hiding annotations</td>
<td>![Show/Hide Icon]</td>
</tr>
<tr>
<td>Select line width</td>
<td>![Line Width Icon]</td>
</tr>
<tr>
<td>Select annotation colors</td>
<td>![Color Icon]</td>
</tr>
<tr>
<td>Delete selected annotation(s)</td>
<td>![Delete Icon]</td>
</tr>
<tr>
<td>Save annotations</td>
<td>![Save Icon]</td>
</tr>
<tr>
<td>Cancel changes</td>
<td>![Cancel Icon]</td>
</tr>
<tr>
<td>Rubber Stamp annotations</td>
<td>![Rubber Stamp Icon]</td>
</tr>
</tbody>
</table>
**Image Toolbar**

The Image toolbar allows you to manipulate images (pages) that have been imported or inserted into AppXtender Document Manager.

<table>
<thead>
<tr>
<th>Function</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display settings(zoom, rotations, scale-to-gray, form overlay) for Image(page)</td>
<td><img src="image1.png" alt="Icon" /></td>
</tr>
<tr>
<td>Fit entire page to Document Display view</td>
<td><img src="image2.png" alt="Icon" /></td>
</tr>
<tr>
<td>Fit page vertically to Document Display view</td>
<td><img src="image3.png" alt="Icon" /></td>
</tr>
<tr>
<td>Fit page horizontally to Document Display view</td>
<td><img src="image4.png" alt="Icon" /></td>
</tr>
<tr>
<td>Rotate image 90 degree to left</td>
<td><img src="image5.png" alt="Icon" /></td>
</tr>
<tr>
<td>Rotate image 90 degree to right</td>
<td><img src="image6.png" alt="Icon" /></td>
</tr>
<tr>
<td>Zoom In</td>
<td><img src="image7.png" alt="Icon" /></td>
</tr>
<tr>
<td>Zoom Out</td>
<td><img src="image8.png" alt="Icon" /></td>
</tr>
<tr>
<td>Use Magnifier</td>
<td><img src="image9.png" alt="Icon" /></td>
</tr>
<tr>
<td>Navigate to previous page</td>
<td><img src="image10.png" alt="Icon" /></td>
</tr>
<tr>
<td>Navigate to next page</td>
<td><img src="image11.png" alt="Icon" /></td>
</tr>
<tr>
<td>Display previous version of a page</td>
<td><img src="image12.png" alt="Icon" /></td>
</tr>
<tr>
<td>Display next version of a page</td>
<td><img src="image13.png" alt="Icon" /></td>
</tr>
<tr>
<td>Show text/image for document</td>
<td><img src="image14.png" alt="Icon" /></td>
</tr>
<tr>
<td>Perform OCR (Optical Character Recognition)</td>
<td><img src="image15.png" alt="Icon" /></td>
</tr>
<tr>
<td>Toggle pan mode/selection mode</td>
<td><img src="image16.png" alt="Icon" /></td>
</tr>
<tr>
<td>Toggle Index view</td>
<td><img src="image17.png" alt="Icon" /></td>
</tr>
<tr>
<td>Toggle form overlays on COLD/ERM Documents</td>
<td><img src="image18.png" alt="Icon" /></td>
</tr>
<tr>
<td>Toggle Previews Subpage</td>
<td><img src="image19.png" alt="Icon" /></td>
</tr>
<tr>
<td>Toggle Next Subpage</td>
<td><img src="image20.png" alt="Icon" /></td>
</tr>
</tbody>
</table>
**Batch Index Toolbar**

The Batch Index toolbar contains commands for indexing batches and navigating document pages.

<table>
<thead>
<tr>
<th>Function</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new document</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Add current page to most recently indexed document</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Add all batch pages to most recently indexed document</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Delete a page from the batch</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Navigate to the previous page</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Navigate to the next page</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

**Scanning Toolbar**

The Scanning toolbar contains commands for scanning and creating electronic documents.

<table>
<thead>
<tr>
<th>Function</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan document</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Rescan document</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Auto feed</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Manual feed</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Single feed</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Front rotation</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Back rotation</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Scanner setup</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Auto enhance</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>
## Function Keys within AppXtender Document Manager

The following function keys perform one-keystroke functions in AppXtender Document Manager:

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>F1: Opens an online help window</td>
</tr>
<tr>
<td>F3</td>
<td>F3: Opens the Search box, for use with text documents.</td>
</tr>
<tr>
<td>F4</td>
<td>F4: Searches for existing document indexes</td>
</tr>
<tr>
<td>F5</td>
<td>F5: Displays the List of Values for the selected index field, when searching</td>
</tr>
<tr>
<td>F6</td>
<td>F6: OCR Index</td>
</tr>
<tr>
<td>F7</td>
<td>F7: Auto-indexes, during document creation.</td>
</tr>
<tr>
<td>F8</td>
<td>F8: Displays the Search Expression box for the selected index field</td>
</tr>
<tr>
<td>F11</td>
<td>F11: Full Screen</td>
</tr>
<tr>
<td>Shift+F3</td>
<td>Shift+F3: Text Search</td>
</tr>
<tr>
<td>Shift+F4</td>
<td>Shift+F4: Searches for existing names.</td>
</tr>
<tr>
<td>PgDn</td>
<td>PgDn: Next Page</td>
</tr>
<tr>
<td>PgUp</td>
<td>PgUp: Previous Page</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Ctrl+A: Attach All Pages</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Ctrl+B: Batch Index (List)</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Ctrl+C: Copy</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Ctrl+D: New Query</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Ctrl+E: Rescan Page</td>
</tr>
<tr>
<td>Ctrl+F5</td>
<td>Ctrl+F5: Duplicate Document</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Ctrl+G: Go to Page</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Ctrl+L: Rotate Left</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Ctrl+M: Batch Import</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Ctrl+N: New Document</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Ctrl+P: Print</td>
</tr>
<tr>
<td>Ctrl+PgDn</td>
<td>Ctrl+PgDn: Previous Page</td>
</tr>
<tr>
<td>Ctrl+PgUp</td>
<td>Ctrl+PgUp: Next Page</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Ctrl+Q: Run Query</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Ctrl+R: Rotate Right</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Ctrl+S: Scan Page</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Ctrl+T: Attach Page</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Ctrl+V: Copy</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Ctrl+X: Cut</td>
</tr>
</tbody>
</table>
Navigation Options

As with most software there is more than one way to navigate while working with documents. Below is sample of the various functions used in Document Manager to navigate while in an individual page or document batch.

Zoom Settings

1. To alter the zoom setting

Or

2. One of the Image toolbar function can be used
Navigating Document Pages

A document batch may have multiple pages. You can navigate through an individual page or document batch by using the Indexing Toolbar or the Document Menu.

Using the Indexing Toolbar

1. If the batch indexing toolbar is not visible select View, then Toolbars, then Batch Index

2. Document pages can be navigated using the Next Page or Previous Page icons on the Indexing Toolbar

Or

Select from the Title bar select Document, then Next Page or Previous Page, or Go To Page

Or
Viewing Page Numbers

You can view the number of pages in an individual document or document batch. The page number is displayed on the Menu bar of the application window.

Viewing the Document Index Box

The placement of the Document Index box can be moved from the default setting. Once a new placement is picked it will be saved until the user changes the view.

1. From the Menu bar select View, then Document Index and choose one of the available options (example Right)
Document Batches

A document batch is a collection of documents that are held electronically within BDMS.

Here at Eastern Kentucky University document batches are usually created via scanning using QuickScan Pro. You can also import electronic documents to create batches using AppXtender Document Manager.

Documents and document batches can be indexed or deleted depending on user privileges.

Viewing Batches

1. On the Menu bar select Utilities, then select Batch Index (List)

Or

Use Ctrl+B keyboard combination
Opening Batches

With the Batch Index (List) open:

1. Use the drop down window to select **Batches for application**

2. Select the **batch**, then Click **Index** to open batch
Create a New Document

There are several methods for creating new documents in AppXtender. Which one you choose will depend on the type of document you want to archive.

Below is a list of type of documents you may want to create and the method that should be use to create an electronically batch.

Options that are not available will be grayed out.

<table>
<thead>
<tr>
<th>If the Document You Want to Create is</th>
<th>Use the Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>A paper document that is not yet in electronic format</td>
<td>Scanning via QuickScan Pro</td>
</tr>
<tr>
<td>An electronic document that is in an image format supported in AppXtender (PDF)</td>
<td>Import File</td>
</tr>
<tr>
<td>An electronic document that is a text file (*.TXT)</td>
<td>Import File</td>
</tr>
<tr>
<td>An electronic document that is a Rich Text Format file (*.RTF)</td>
<td>Import File</td>
</tr>
<tr>
<td>An electronic document that is a Hypertext Markup Language file (*.HTM or *.HTML)</td>
<td>Import File</td>
</tr>
<tr>
<td>An electronic document that is an Adobe Portable Document Format (PDF) file (*.PDF)</td>
<td>Import File</td>
</tr>
<tr>
<td>An electronic document that is an e-mail attachment in Microsoft Outlook</td>
<td>Import File</td>
</tr>
<tr>
<td>An electronic document that is in a format not natively supported by AppXtender and that you would like to</td>
<td>Import File</td>
</tr>
</tbody>
</table>
index using full-text indexing

An electronic document that is in a format that is not natively supported by AppXtender and that you would like to work with within the application in which it was created using ODMA

Import File

An electronic document that is in a format that is not natively supported by AppXtender and that you would like to work with within the application in which it was created using in-place editing in AppXtender (Note that documents brought into AppXtender as objects cannot be submitted for full-text indexing.)

Clipboard Paste or Clipboard Paste Special or Insert Object

A fax in a fax server queue

Fax-in Queue

**Scanning**

The Scan function creates a document from the image your scanner generates. It is strongly recommend that all scanning be performed using the workstation that has QuickScan Pro and export to AppXtender Document Manager.

**Windows Clipboard**

If you have a file in the Windows Clipboard, you may paste it to document directly. If there is no valid or usable data in the Clipboard, this option will be grayed out.

Clipboard Paste pastes the data in the default format; Clipboard Paste Special allows you to specify the format of the data.

**Clipboard Paste Example**

1. Highlight **Application** you want to insert the clipboard, right click select **New Document**, select Clipboard Paste
2. Information will appear, proceed with indexing

**Insert Objects**

This function will insert files from various other applications. (i.e. Microsoft Office documents, media clips, image files or sounds) The file may be displayed as an icon, or as the beginning of the file with visual components.

1. Highlight the **Application** you want to insert the object, right click select **New Document**, select **Insert Object**
2. There are two options to choose from:
   • **Create New** – Inserts a new Object Type (allows you to chose the entire object)
   • **Create from File** – Browse your PC and select the file to insert (allows you to chose a portion of the file)

3. Click OK depending on the option you chose following the steps

**Import Files**

Documents that are received electronically can be imported into Document Manager directly rather than printing the document then scanning.

Batches that are created this way are visible in the batch list and should be indexed in the same way as scanned batches.
1. Highlight the **Application** you want to insert the information, then select **New Document**, then select **Import File**

2. Navigate to the file(s) you want to import then select.

**Note:** If the PDF file contains more than one image (page), the batch created by this method will enable you to index each document separately as required.

3. Enter **Batch Name**, Click **Open**
4. A status box should appear detailing how many file processed, pages imported, and rejections.

![Batch Import Status](image)

5. You can View Log or click **Exit**. (see example of the Log)

If you click View Log you will see the Destination Application and Batch Name. If there were to be any rejections it would detail the information.

*Note: If you have rejections do not delete log print screen and forward to ITDS for help.*

![BI_A09CLOG - Notepad](image)

The new batch will be visible in the **Batch List** waiting to be indexed.
Create a New Batch

Other than scanning a batch using QuickScan Pro you can also create a batch using Document Manager. Save the documents as a PDF file on your computer and following the steps below to create a new batch.

1. Highlight the Application you want to create the batch in.

2. On the Menu bar select Utilities, then click Create Batch

3. Navigate to the file(s) you want to import then select.

Note: If the PDF file contains more than one image (page), the batch created by this method will enable you to index each document separately as required.

4. Click on the Document, the File Name will populate, enter Batch Name, Click Open
5. A status box should appear detailing how many files processed, pages imported, and rejections.

![Batch Import Status]

6. You can View Log or click Exit. (see example of the Log)

If you click View Log you will see the Destination Application and Batch Name. If there were to be any rejections it would detail the information.

**Note: If you have rejections do not delete log print screen and forward to ITDS for help.**

![BL_CC6E.LOG - Notepad]

The new batch will be visible in the **Batch List** waiting to be indexed.
Close an Electronic Document Batch

Electronic Document Batches may need to be close during the indexing process or if the batch was not to close after all documents were indexed.

1. On the Menu bar select File, then click Close
Index New Documents

New documents are indexed, so that they can be retrieved within the database via queries. The fields available for indexing the new document are dependent on their associated application.

There are two options available for indexing:
- Batch Index (List) – Listing of all batches associated with an application
- Batch Index (Single) – Specific batch name needed

General Notes: Index

- During indexing the Enter key is the same function as the Save Key. Do not use Enter key use the Tab key.
- If all of the pages within a batch go to one document use the Attach All function to index complete batch.
- Anyone can delete pages within a batch. It is not until the save function is committed that an individual needs security rights to delete the indexed pages
- Routing Status Field is a pre Xtender Solution field. This field can be used in a department as a specific query or workflow field. The caught if the field is left blank by mistake it will not be picked up in the query using Routing Status.

Open Single Batch File to Index

In order to open a batch via Batch Index (Single) you must know the name of the batch.

1. On the Menu bar select Utilities, then Batch Index (Single)
2. Enter the name of the batch when prompted

3. Click OK

4. The batch will open and indexing can begin.

---

**Open Batch File to Index from a List**

1. On the Menu bar select **Utilities**, then **Batch Index (List)**

   ![Batch Index Window](image)

   Or

   Use the **Ctrl+B** keyboard combination

2. Select an **Application** from the drop-down box

   ![Batch Index Window](image)

3. Highlight the **Batch** you want to index
4. Click **Index**

5. Check the status of the batch. The batch **MUST** be **Idle** to open and index.

6. The batch will open and indexing can begin.
Batch Error Status

If the status is NOT Idle the batch has probably not been closed properly on completion of scanning or AppXtender shuts down unexpectedly or AppXtender sis closed using the Task Manager tool on the PC. If this error occurs contact the System Administrator

Deleting Batches

You must have the security setting to delete a batch.

1. Open the Batch Index (List), select the batch you want to delete

2. Click the Delete button on the batch Index pane

Or

Highlight batch, then right-click, then click Delete
3. Click Yes to the warning message

Assign Index Values for Documents

Example: B-F-DOCS Banner Finance Purchasing A/P

1. Once Index has been selected on the Batch Index pane the document batch will be opened ready for indexing.

2. The documents contained in the open batch are shown in the main application window.
3. The number of pages in the electronic batch can be viewed on the Title bar. This should be the same as the number of pages in the paper batch that was scanned or imported.

![ApplicationXtender Document Manager](image1.png)

4. Pages in the document batch can be scrolled through by using the **Next** and **Previous** page icon on the **Batch Indexing** toolbar, OR by selecting **Next Page/Previous Page** or **Go To Page** from the **File Menu** OR **Keyboard Commands**. (see Navigation Option for screen shots)

5. Select **New Document** from the **Indexing Toolbar**

![Indexing Toolbar](image2.png)

Or

On the **Menu** bar select **Document**, then select **Batch Index**, then select **New Document**

![Menu Bar](image3.png)

Or

Keyboard commands **Ctrl** + **N**
6. The Index pane will open

7. Each application Index pane has fields that are required. These fields are in bold lettering and must be filled in before you can save.

8. Enter Document ID, then click Tab key. (DO NOT USE the ENTER KEY)
9. If you hit the Enter key the following error will occur. Click **OK** and fill in the missing information.

   ![ApplicationXtender Error Message]

10. If the Document ID is information held in Banner for the document will be retrieved. The user will then need to fill in the Document Type.

11. Once all fields are filled in on the Index pane select **Save**
12. The following window will appear. Select **OK** to continue or cancel to edit

![Image](image1.png)

13. Additional pages within the batch can be added to the Document ID that is being used to index by selecting Attach Page or Attach All from the **Index** menu.

Once all pages have been attached to the Document ID there are several options:

- If the batch still has additional pages to index select New Document from the Index menu.
  ![Image](image2.png)

- If all pages have been indexed within the batch a window will appear asking if you want to index another batch.
  ![Image](image3.png)

No – Will close the Index pane

Yes – Batch Index pane appears select **application**, then **Highlight** batch, click **Index**

![Image](image4.png)
Close the Electronic Document Batch after Indexing

If all of the document pages in the electronic batch have been successfully indexed, Document Manager should recognize that the electronic batch file is now “empty” and ask if there are further batches to index.

Adding a Page by Importing a File

You can create a new page by importing an existing file.

To add a page by importing a file:

1. Query the document that you want to add the page. Right-click on the application, then select New Query.

2. Enter the Document ID, then select Search.
3. Highlight the **Thumbnail** that you want the images/pages to appear before or after.

4. From the **Page** Menu, select **New**, then Import File. A short cut menu appears.

5. You have three options:
   - **Insert After** – New page to be added as the next page in the document (after the currently displayed page).
   - **Insert Before** – New page to be added as the previous page in the document (before the currently display page).
   - **Append** – new page to be added as the last page in the document.
6. The Import File box appears, allowing selection of any file. Navigate to and select the file that you want to import and click **Open**.

![Import File dialog box]

7. Import Status Box will appear. You can cancel the import if needed.

![Import Status dialog box]

8. Once the import has been completed the new page will appear.

![Imported page]

9. Once you have added all the pages to the Index close the document. Select **File**, and then **Close**.
Adding a New Page Version

A new version of a page can be an altered version of the original page, or it can be completely different.

To create a new version of a page:

1. Query the document that you want to add the page. Right-click on the application, then select New Query.

2. Enter the Document ID, then select Search

3. From the Page menu, select New Version and select the source for adding the new page version.

4. The Import File box appears, allowing selection of any file. Navigate to and select the file that you want to import and click Open.
5. The status bar and title bar indicate the new number of versions of the page.

6. Once the import has completed a new page will appear.

7. Once you have added all the pages to the Index close the document. Select File, and then Close.
**Viewing Versions of a Page**

If more than one version of a page exists, the newest version is displayed by default. You can access all other versions through the Page menu, the Page version toolbar buttons.

AppXtender orders page versions as they are created. The original page becomes version 1; the next variation of that page is version 2; and so on. System-generated version numbers are displayed in the status bar and the title bar.

A single version can be deleted using the Delete Version command in the Page Menu.

**Note:** *As soon as the deletion is confirmed, the version is permanently lost. Caution should be exercised because recovery of the version is not possible.*

To delete one version of a Page:

1. Query the document that you want to add the page. **Right-click** on the application, then select **New Query**.
2. Enter the Document ID, then select Search

3. From the Page menu, select Delete Version.

4. A delete page version confirmation message appears. Click Yes to delete the version. No to exit without deleting the version.

5. Once the command has been performed the page will be deleted and no longer appear in the Index. The toolbar will reflect the change.
Purging a Version

The Purge version feature allows you to delete several versions of a page with one command. Document Manager deletes all versions created before the displayed version.

If there are six versions of a page, for example, and version four is displayed, purge version would delete versions one, two, and three. Versions four, five, and six are preserved and renumbered to one, two, and three. This is useful when only the most recent version of a page is required.

**Note:** As soon as the purge is confirmed, the older versions are permanently lost. Caution should be exercised because recovery of the versions is not possible.

To purge a version:

1. Query the document that you want to add the page. **Right-click** on the application, then select **New Query**.
2. Enter the Document ID, then select Search

3. From the Page menu, select Show Version, then choose the version you want to keep.

   **Note:** If there are six versions of a page, for example, and version four is displayed, purge version would delete versions one, two, and three. Versions four, five, and six are preserved and renumbered to one, two, and three. This is useful when only the most recent version of a page is required.

4. Look at your toolbar to see what version you are on.
5. From the **Page** menu, select **Purge Version**.

6. A purge page version confirmation message appears. Click **Yes** to delete all versions created before the displayed version. Click **No** to exit without purging the versions.

7. Once the command has been performed the page will be purge and no longer appear in the Index. The toolbar will reflect the change.

---

**Pulling Pages from Assigned Documents**

You can export an entire document or a specific page to any available file location.

**Note:** Only users with the Print privilege can perform operations that result in information exported from the Document Manager. These operations include exporting documents, and pages. If you have questions about the privileges assigned to your Document Manager user profile, consult your supervisor.
To export a document to a file:

1. Query the document that you want to add the page. **Right-click** on the application, then select **New Query**.

2. Enter the **Document ID**, then select **Search**

3. From the **Document** menu, select **Export** and then **Images**

5. Enter the name and path of the files to be exported.

6. Specify the pages to export. You have the following choices:
   - To export all pages of the document, under Page Range, select all
   - To specify page ranges or individual pages, under Page Range, select Pages and type comma-delimited page numbers in the text box. Use a dash to indicate a page range. For example to export pages 2, 3, 4 and 7 of a document type “2-4, 7” in the text box.

If a selected page contains subpages, every subpage in the page is exported.

**Note:** If you export more than one page you will have a file for each page. **Example:** Export 9 pages you will have 9 files.
7. If you do not want annotations to be included on the documents you are exporting, click the Hide annotations check box.

**Note:** The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your supervisor.

8. Click **Save**. The document is exported.

Note: If the Use multi-page files option is enabled, certain files are combined into one file.

9. When Document Manager has finished exporting the documents, you can look in Windows Explorer to view the exported files.

---

**Indexing Documents that are Out of Order**

Sometime batch pages may not be in order and you will have to add a page to an existing indexed image.

1. Enter the **Document ID**, then on the keyboard hit F4.
2. Result page will display, select

3. Banner information will appear. You must select the Document Type

4. Click Save, the new page is appended to the end of existing pages

Note: If there is more than one page that needs to be attached to an index you will need to follow the steps above for each page.

Copy an Index

To copy Index information that already exists to use on a new Document ID

1. Enter the Document ID, then on the keyboard hit F4
2. Result page will display, select **Copy**

3. Existing Index information will appear

<table>
<thead>
<tr>
<th>Fields</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCUMENT ID</td>
<td>0273817</td>
</tr>
<tr>
<td>BANNER DOC TYPE</td>
<td>INVOICE</td>
</tr>
<tr>
<td>DOCUMENT TYPE</td>
<td>INVOICE</td>
</tr>
<tr>
<td>TRANSACTION DATE</td>
<td>01 Sep 2009</td>
</tr>
<tr>
<td>VENDOR ID</td>
<td>591101592</td>
</tr>
<tr>
<td>VENDOR NAME</td>
<td>CASE</td>
</tr>
<tr>
<td>FIRST NAME</td>
<td>JEREMIAH</td>
</tr>
<tr>
<td>PDM</td>
<td>1101592</td>
</tr>
<tr>
<td>ROUTING STATUS</td>
<td>(null)</td>
</tr>
<tr>
<td>ACTIVITY DATE</td>
<td>2009-10-02 15:24:25</td>
</tr>
</tbody>
</table>

4. Enter New Document ID

<table>
<thead>
<tr>
<th>Fields</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCUMENT ID</td>
<td>027210</td>
</tr>
<tr>
<td>BANNER DOC TYPE</td>
<td>INVOICE</td>
</tr>
<tr>
<td>DOCUMENT TYPE</td>
<td>INVOICE</td>
</tr>
<tr>
<td>TRANSACTION DATE</td>
<td>01 Sep 2009</td>
</tr>
<tr>
<td>VENDOR ID</td>
<td>591101592</td>
</tr>
<tr>
<td>VENDOR NAME</td>
<td>CASE</td>
</tr>
<tr>
<td>FIRST NAME</td>
<td>JEREMIAH</td>
</tr>
<tr>
<td>PDM</td>
<td>1101592</td>
</tr>
<tr>
<td>ROUTING STATUS</td>
<td>(null)</td>
</tr>
<tr>
<td>ACTIVITY DATE</td>
<td>2009-10-02 15:24:25</td>
</tr>
</tbody>
</table>

5. Click **Save**, the new page is appended to the end of existing pages

*Note: If there is more than one page that needs to be copied to an index you will need to follow the steps above for each page.*
Annotations

Assuming you have been granted the appropriate user privileges, several types of annotations are available to you when viewing documents. You can add manual marks, such as lines, arrows, and highlights, to a page to emphasize information. You can add shapes such as ovals, rectangles, and rounded rectangles. You can add comments in the form of text, and display them as either actual text or sticky note icons.

If you have access there is a show/hide feature to hide the annotations with a single click that will allow you to print or email the document either with or without annotations.

There is no limit to the number if annotations you can place on a page; however, a large number of annotations could slow down or distort page rendering.

Only users who have appropriate privileges can create, modify, move, hide, or delete annotations and redactions.
Annotation Commands

1. If the toolbar is not visible, on the toolbar select View, then select Toolbars, then select Annotation.

Or

Annotation can be performed by using the Annotate menu from the Title bar.
Creating Annotation

There are several types of Annotation that can be created using the Annotation Toolbar. Below is an example of a Text Box.

1. Select **Annotation** type from toolbar (Example: Text Box)
   Click on the area within the document that you want to enter the information.

2. The Annotation Text Editor window will appear. Type in your message. Click on Advance to edit the Font.

3. The Annotation can either appear as a post it note or text string.
4. Correction can be made by clicking on the Annotation.

![Annotation Text Editor]

5. You can delete the Annotation by highlighting then click **Delete** on your **Keyboard** or use the **Annotation menu**.

---

**Turning Annotation On & Off**

If you have access there is a show/hide feature to hide the annotations with a single click that will allow you to print or email the document either with or without annotations.

1. On the Annotation toolbar click **Show/hide button**. This will turn on/off the annotation.
Queries

A query is a process that searches the documents in the database. You may query a single application or search across multiple applications, and search on either index fields, the text contained in the documents or both.

The query function is also used to:
• Correct previously index information that is wrong
• Addition document pages can be added to an indexed document
• Copy previous index information to form the basis for a new index

Users of the BDMS Finance applications should be aware that Fund/Org security is enforced on BDMS documents. When a query is performed, all documents that match the query criteria will be displayed if you have Fund/Org security to view the document. If not a security message will display that you are not authorize to view the information.

Query a Single Application

1. To query an application, right-click its name in the Application view. Form the shortcut menu, select New Query.

Or

From Title bar select Edit, then New Query

Keyboard commands Ctrl + D
2. Enter the Query Criteria into the fields provided for the application that you are running the query (Example B-F-ID BANNER FINANCE COMMON)

3. Click Search

4. A list of all the matching documents will display in the **Result Set** window

5. Double click on any document to view. The stored index values are visible in the **Result Set** window use horizontal scroll bar if needed.
6. View the **Index** pane by clicking on the **Menu** bar, and then **View**, then **Document Index**, then chooses one of the available options (Example Left).
**Saving a Query**

1. Follow the steps to create a query

2. Click on the **New Query** then select **Save As**

3. Insert a name for the query

   **Note:** If you want to make this query available for others check “Available to all users” box

4. Click **OK**
5. Saved query will appear with the new name that you choose

Running a Saved Query

Saved queries are listed in the application menu under the application that the query was saved under. (Example B-F-DOCS-BANNER FINANCE PURCHING A/P)

1. If the list is not expanded, click on the plus sign to expand the list of available queries

2. Select the relevant query

3. There are several ways to activate the query list below are only two options;

   Click on the Run Query icon on the Main toolbar

Or

   Right Click on the query and select Run Query

The query results will be displayed in the Result Set window
**Editing Queries**

1. **Highlight** the query that you want to edit

2. Select **Edit Query**

3. Make the required changes to the query criteria

4. Click **Save** to save the changes to the query

**Deleting Queries**

1. **Highlight** the query that you want to delete

2. **Right Click** on your mouse

3. Select **Delete Query**